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1. M3ANRIITUDLMASeIRRNN MBI A IUYAAS
4 s a ug.:’ % usz} I % ] 1 J 4 )
yorauIsnIFumMsAnAe Fanaruaily Freeware ¥4 lutia 19918 1a o o1y
. . .
1.1 AppServ 2.4.4a ¥3e13130 A4 11iaa 1391 http://www.appservnetwork.com %4
Y a 3 1 {o o Y va o ¢
Tdsunsuil azanda Tusunsusan sl Taedn Tusia dail
< ad 4
® Apache 1.3.33 - UGS W05
® PHP43.11 - auilaniy) PHP
® PHP MyAdmin 2.5.7 - n5esleanelunmsdamsgiudoya

® MySql 4.0.24 - gudioya

Imsannalilsunsu AppServ 2.4.4a

[y Qy a 14 . A o A Y a o’j
1. ‘]J!,‘Uﬁﬂaﬂvl,%lﬁ appserv-win32-2.5.6.exe Na11 Inaau MBVIFNTSUIUNITANN]

[3

931 0.1

U

File Edit Miew Fawvarites Taools  Help

GBack - -\_}J e lﬁ
Address Ila C:happ

Mame = | Size | Type | Date Modified |

Eappserv-win32-2.4.4a 11,631 KB Application 3112550 18:23

f_jSearch Y Folders

5 3 X |-

31 n.1 uaaddsmsanaalilsunsy AppServ 2.4.4a
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d k4 Y
2. wlsinguiusnueImsisuAaas naenniuaanijy Next aagi n.2

Welcome

Easy way
to install

Ywelcome to the AppSer: w2 4.4a Setup program. Thiz program will install
AppSery w2 4.4a on your computer.

It iz ztrangly recommended that you exit all ‘Windows programs before
unning this Setup program.

Click Cancel to quit Setup and then cloge any programs you have running.
Click Mest to continue with the Setup program.

WwOSBMIMG: Thiz program iz protected by copenight lavw and international
treaties.

Unauthorized reproduction or distribution of this program, or any portion of it,
may result in gevere civil and criminal penalties, and will be prosecuted to
the maximum extent poszible under law.

S Hack

X

Cancel |

9
g1l n.2 ngasmaitngmsaaaslalsunsu

9 v
3. dendnadalisunsu 13 TWames C\AppServ 1danantjn Next Aagil n.3

Choose Destination Location

Easy way

A

Ja

Setup will inztall &ppSery v2.4.4a in the following directory.
Ta install to thiz directon, chick Mesxt.
To inetall to a different directony, click Browse and select anather directany.

Yiou can choogze not to inztall AppSery w2 4.4a, by clicking Cancel to exit
Setup.

IE:'\.-'i‘«ppS ey Browse. . |

Space Required: 27324 K
Space Available: 10971720 K

"Qestination Directon

< Back

Cancel |

X

Y '
51/ n.3 nanamsdondadalusunsy3nTnlames C:\AppSery
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A A Y 3 a a o 3 a
4. enaugdnw e nszuvasllsunsudulszansaim naaniunan Next

Aagl n.4

Setup Type il

Click the type of Setup vou prefer, then click Mest.

& Typical Frogram will be inztalled with the most comman
optiohz. Recommended for most uzers.

Easy way
to install
for you. " Compact F'n:n_gram will be installed with minimurn required
oplionz,
Only Apache \Web Server
£ Cuystom You cah choose the options pou want ta install

Fecommended for advanced uzers.

M Space Requied: 27924 K
Space Available: 10971716 K
Cancel |

¢ Back

31l n.4 naaamsidenlilsunsudoy
° A Ad sAQY 1 Ao a < ]
5. MrUALBANTAYDUATBUFTWNDIN I FaIDdIAUAz DINAIDAINI TVDIHAIAZ TV

9
Tildmauwgiam vminldnand]y Next sl n.s

Apache httpd Server
Server Information
i Please enter vour servet's information.
Easy way Server Mame [e.q. v mydomain. com or localhost] ;
to install |M

for you.
Adminigtrator's Email Addrezs [e.q. webmaster@ mydomain. com) |

|ynumame@myhnst.cnm

HTTF Part [default : 80)

i

¢ Back | Meut = Cencel

° A Aad s a < 9
gﬂ .5 LlﬁﬂﬂﬂﬁﬂWﬁUQLLﬂﬂLﬂiﬁﬂlﬂﬁlﬂiﬂM“}ﬁWlﬂﬁ)ﬁllazﬂmaLL@ﬂLﬂiﬁﬂJleﬂ{g]L!ﬁ%i%‘]J‘]J
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o v 1 d' 9) 9y =K 9 9 1 v 1 d' 1 9
6. fmuasarunzldlumsindagiudeya MySQL T ldsiarunniuasnis
s 1 3 ] anl 1 4
Aunti ¥ lailu root ) tionn 11 tis620 nasantiulinalu Install iloasTusunsy

Aag .6

MyS0L Database

Server Information R
Please enter your MySOL infomation., M HS EIL
; Easy way Jzer Mame [e.q. apples | :
=) to install Im_lrlgql

for you.
Pazaward [e.q. mypaszsword | ;

xxxxx

¢ Back | et = Cencel

° v 1A Y, Y = Y
z‘ﬂ .6 u,ammimwuﬂ‘iwﬁmumzi«ﬂunwmmgmmaya MySQL

PR < ¢y v a v
7. 5ﬂﬂuﬂﬁg‘ﬂ\‘]ﬂﬂﬂﬂjﬂillﬂﬁﬂJ%HLﬁi%ﬁil‘]aljﬁf;l‘!E]"I‘H1ﬂ§l’t)\1ﬂTiﬂﬂ!aﬂﬂTiaﬂIﬂﬁllﬂiNTﬁ

Aan 1)y Cancle A3 n.7

ﬂ AppSery v2.4.4a Setup

AppServv2.4.4a Setup

setn | ) 1.0 A VNSRS

@ Please standby )
http:/iwww. AppServNetwork.com ﬁ

Powered by apples #25

Cancel

This installation was created with Installer YISE
from Mind' ision Software
httpe A mindvision. com

31U n.7 ugaamsmsaada llsunsu
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8. wieudaulonlisunsy AppSery 2.4.4a 1381500 nATju close Avg1 .8

i @ Setup iz complete and AppSery v, 4.4a iz how installed!

Easy way| [ Statapache
* to install
for you.

v Start MySOL

Click Cloze ta Finish Setup

< Back [Earze]

a o < ¢
71 .8 naaansfada Tlsunsuanasvauysol
A <3 9 1 A 3| ad d A o
9. LﬂJﬂZNI‘]Ji!Lﬂiil AppServ 2.4.4a L&@32L407 NAFOVINUATOIVDUT W U W05 1T 0
a d? Y A Jdo 1 ] 9 Y d?
Iﬂt’Jfﬂﬁ!ﬂJﬂ Brower YUNUAINWNUNWAII localhost Glusb'fN Address DININYNADIVSUU

W9 A9l n.9

3 AppSery Open Project 2.4.4a - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

eﬁack - -J - @ @ _h ‘ /__j Search ‘i}(Favorltes -€‘3| i :‘?__ - _‘J

Address [ @] hitp:flocalhostf

The AppServ Open Project - 2.4.4a #usu 3u1ad

;,8 phpMyAdmin Database Manager vafiiu 2.5.7-pll
#J PHP Information vaa58u 4.3.11

drafiuTysun s AppSery vaidy 2 4 4a dwdy Gulad
AppSery fis T sunssfisusan lasiuse fesaviviu frene afnadnieiu Tned

« Apache Web Serveriaéiu1.3.33

« PHP Script Language vaiu 4.3.11

« MySQOL Database 1235 4.0.24

« phpMyAdmin Database Managerio§iu 2.5.7-pl1

o diozlslu

o Tdsminu <— ngandrwioen sy

o Fenfvifind

o igEving

o httped femien Ap pSerNetwork.com

Wisunt ; —

% asradwdsrhnas, andwusiisviioasinug ha AppSery :-)

A < Y
gﬂ .9 LLﬁﬂ\‘lﬂTﬁliJfJa\‘lIﬂi!LﬂﬂJ AppServ 179107
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2. M5AANI ArGoSoft Mail Server
3 { ° 4 g s ad o Y
ArGoSoft Mail Server 1WuldsunsunlFlumssraounsoudumdidivnes 3dwmsuy
a 4 1 o < @ []
nageylumseuaasilaniviansg ilvansoveuriuamlumslsauldiuiTagli

9 o A 1A =]
ADININIILBDUADDUINDTLUA

d o
sz aviivian
A (& o P ' P P ' P S
ldnaaevlums@eouaasddnenums 1wy uuuvesuduud, Msaduudiandn,
MU TINTU web programming
o v ] ~ A v = dlal o q ¥
MU FMIUYUI8Y 1535 8UKNT a1 UNsANEINAINsIszuLa lgaunely
#e (Intranet mail) NIATDINFI WU TUA
a P Y] 4 o @
1¥Tumsaew/eusy 3T MS  Outlook  u3FoTUsunsuiperduwd (d115y

o = ~ ] sld'l T Aa LA~
’L’fﬂﬁJ‘L!ﬂ1iﬁﬂHWlllil]lﬂl"]fﬂuﬁ@ﬁ]umﬂimﬁ)

v
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o { g 4 a
1. @unsoai lnaaldsunsu1an Buled hip://www.argosoft.com liinaniden

m’aﬁwamﬂu ArGoSoft Mail Server (Freeware) ﬁﬁg‘ﬂ n.10

[ Ty T

Lo

SEOFTWARE DESION

T Hews
E Mail Server .ﬂ FTP Server
T, Mail Transter £ .NET Stuff
] Ll

< Jd o o o .
s n.10 neraadn o drusuaniiTnan ArGoSoft Mail Server
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[ o Y a U . d' a ag]} [
2. #waIMIalvaalinanijy agsmail.exe tNONNMIAAAY A931 n.11

&

agsmail

1 n.11 TanldeimsanniiTnaan

] Y
3. Aantu Setup MeINIsAAAT A931 n.12

WinZip Self-Extractor - agsmail.exe

% ArGoSoft Mail Server Freeware v1 .8.6.0

Cancel

i

About

9 9
71 112 AR UABUMIAAAITL U

' < o
4. nlaguieunuwan Program Directory 910 c:\Program Files\ArGo Software

Design\Mail Server\ 1111 ¢:\Mail Server\ ta5audIaantjy Next> aag1l n.13

Settings  Install

ArGoSoft Mail Server Freeware Installer

Program Directony: |2 ail Server's

[v Create Shortcut on Desklop

[w Create Shortcut on Start Menu

. ) .
51 n.13 uaasmsilaeureunumah Program Directory
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5. Aaniu Start Installation WOIFUINIAAAT a3 n.14

ArGoSoft Mail Server Freeware Installer =

Settings || Install

Start Inztallation |

< Back Einizh

J k4
71 n.14 13uMIIMIAada

Y
k)

a <3 Y a A
6. TEUULTAINITAAAITUID Gl‘ﬁﬂaﬂ‘ﬂ

W OK 1@z Finish 7431/ n.15

Q

ArGosoft Mail Server Freeware Installer

Settings || Install

Start |nstallation

Copying image; ] =g of 40
Copying imageRULLU i E L] Ll o 40
Copying image pg. 39 aof 40
Copying image . ;

Croating D 1 Installation has been completed

Reaizterng Ac 2

Proceszing libr
Adding uninzt
Creating zhortg
Creating zhortg
Adding items ko programs menu

¢ Back Einizh

9
a o o d
Eﬂ .15 UAAINITAAAITUITD
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1 2
7. NS Start Lﬁ’e)!gﬂﬂﬁl%}ﬂu fan Start > AAN ArGoSoft Mail Server w%ﬁm‘uaﬂaﬂ

'londu ArGoSoft Mail Server U Desktop ﬁﬁgﬂ .16

Arizosoft Mail Server

Programs

Daocurments

e

n:IIt v, jp QuickCark_w..,
Setkings

Search "'h -a
tind

Help and Support - Pokatoes & QuickForum_..

a

ndex. bkl RetinaSasse. ..

S

Run...

Log OFf arnut. .,

©
| -
S
oy
L]
&
[=]
L
o
0.
|
| U
Z
[=]
=
=

Turn OFF Computer. .,

BE Q

Y M f h’ q. F '-ﬁ a. F a M iy

31 n.16 M3 Start tiveiFen g

8. Aanlu OK Av31) n.17

Erron [z|

Relay will be turned off. To allow it, please specify sufficient
data in the Cptions dialog box

51 n.17 Aaniju OK
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M3USUUAI ArGoSoft Mail Server NOUMI1FIIUDII

Y v
1. euananh Ulf]ﬂﬁ]u ArGoSoft Mail Server 1Y Taskbar ﬁﬂgﬂ .18

51 .18 u@a Tonou UL Taskbar

2. AanWY File > Stop (Ctrl + P)

3. AanIuY Tools > Options @I WazDYA Tam fag1l n.19

‘& ArGoSoft Mail Server
Sl Tools Hglp ‘

b rE ViewlogFile  Crr+L @

GrG View Previous Logs Serw
&/g - — - - — | Berw
&S E -¢- |:| |:tr|+|:| =2r Se

- r sta
Mes ﬁi} Users Ctrl4U
ir .
Hig ¥9 Dvnamic DMS
Da= % vy
Sws AckiveX Library *
Max
Local host: langsad
Local addresses: 132.168.10_Z2
Local host after rewverse look

A =
§J‘1J .19 MINNTIazoen Tamuu

< A = Y L~ 1q Y a ~ A
4. Wiy General 7l DNS Server : N3dinodunosiiaeg1inani 1n3091110 / 5210092
0 9 J a 19 Yo va { ] 1 < Jq 1
Amsdudu DNS vesgudusmsunlalionTuda nsaid hildaedialdldiiu

WUNYIAY ip address INT09AUIOI 4931 1.20

§ S < e =

#1 Local Host : 3219 1unsaiis onldauuud iy (Webmail) Tuniildtlanis

v 4 {2 & x <
< I laiununeavip address tnFosauealuiiiliidendudawdiunanty

fa31l n.20

U



82

= 19 Yas A Jd 3
sl 1435 E onuaruy n awe o«
ﬂimmﬂlwmnu

@118 114 Outlook)

Options Options
Loggin ~ SMTP Authentication Logging | SMTP Authentication
General | Local Domains Portz | General | Local Domains Ports
DMS Server. | 2031468665 | W o NS Server: | 203.146.56.65 |
[ Load Server at Windows Startup |/l [ Load Server at Windows Startup
Avtornaticallty Start the Server ; Autarnaticallty Start the Server
[T Allows Belay | [] &llow Belay

[T Hide Passwards In Logs [ Hide Pazswords In Logs

I Local Host: | Local Host: 192 16810253
Do Hat Uze \Web Interface Bl [ Do Mat Use wWeb Interface
’ Allow Creation of Accounts from web [ Allowe Creation of Accounts from Web

When Bouncing, Include Original Mezzage

When Bouncing, Include Onginal Meszage

[ Ok, ] [ Cancel ] [ Help ] [ Ok, ] [ Cancel ] [ Help

71 1.20 38ms3en 14 Ta)sunsu

o . oa oA Ay o v ALy
5. 4N Local Domain WNW%@I@!NHT’I@'ENﬂ’li‘ﬂﬂﬁ't’]‘]Jﬁ’lil’]iﬂ@mﬁ’]u@@ﬂﬂ’]iiuﬂu@ﬂ

[

S| ] < 9y a
111 siamcom.co.th ta5audINANT|y Add A331 n.21

A E_ggging__ | SMTP Authentication -
% Local Damains IEDH—S|

Fiameom, co.th |
1
Feplace [ Add ] [ Delete ] I

’ ] 4 ] [ Cancel l ’ Help ]

<3 .
E‘IJ .21 t1NU Local Domain
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6. it Port LAAIMIIOEAY port H1T3enldan it miowan lidonl s
ozl5) Asgil n.22
- SMTP (Simple Mail Transfer Protocol) Tddmsudand < port 25
- POP3 (Post Office Protocol) 1%}1uﬂ1iﬁdluﬁ%1ﬂ mailbox 1911 < port 110
- Finger 1¥m37va0us100z1800 19 < port 79

J 4
- Web Interface (380 19O UNAMUNIIHTIUI1IEDS < port 80

Options E|
| loggng | SMTP Authentication
General || I:oc:al Domains | Ports
= &
Wweb Interface
I Ok l ’ Cancel ] ’ Help ]

<3
71/ 7.22 N Port

3 . 9 3 < J Y J 9 < Y <
7. iU Logging 1¥lumsinuaen lldmslsavmaues user ﬂimmqmimu"h@,ﬂ

a @ ] <] 1o & a @
annsanandonaagl winlidesmsmues s liduiludesnaniden degil n.23

Options g|
General Local Domainz F'orts
Logging ~ SMTP AL Authentlcatlon -
Log SMTP Commands
Log POP Commands

[ Log SMTF Conversations with Exchangers

Logweb Commands
Log to File
I ok l ’ Cancel ] ’ Help ]

= .
gﬂ .23 NV Logging
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(1 . . Y 9 1 s a =] a
8. UNU SMTP Authentication Gl“b'ﬂll‘lﬂﬁﬂ‘lﬁﬂ\iﬂ']iﬁ\‘]mﬁ@@ﬂjaﬂ@ulﬂﬂﬂuﬂﬂiﬂﬂ FtU

Jd a { yw T 5 [V
ADINTIV SMTP Server voaguivsmsareTuniida ludeutlaldam degil n.24

Options

_ LGeneral l__L-ﬁcaIrDornains 1 Ports |
Logging SMTF Authentication

l_ [] Enable SMTP &uthentication
Uze POP3 User Mames and Fasawards |

|
|

10T &Lthenticate Following 1P

[_ ag H Cancel ” Help

51/ n.24 AU SMTP Authentication

9. aanily OK ietiuninmsulasuilas dagil .25

Information b__<|

= ‘ou hawve modified message size limit information.
\lf) The change will nok take effect until vou exit the
server, and skart it again.

31l .25 AGN1jy OK 1ivetiuin
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MINN Mail Account 19155V

@ @ 1 < A o A 4 ) [
‘Viﬁ\1%1ﬂﬂi°ULI,GNLﬁi%tiﬂﬂ%ﬂﬂll%ﬁiﬁlﬂ1ﬂ1iI,Wlli'lﬂ%ﬂ user A1MIUNATDUIEUU

aag1l .26

1. ANy Tools > Users (Ctrl+U) 431 n.26

‘& ArGoSoft Mail Server

=¥ View Previous Logs Serwer :
== — — ~| Serwver :
548 & Options Chrl+o  [BF_Berver
6.-‘@ ¥ startir
Mes | Chrl+U
i .

Hig ¥V Dynarmic DNS
Des ava  —
Sws pActiver Library *
Max _

Local host: lanogsad

A
31 1.26 1@@AIY Users

2. Aan# Add New User #1931 n.27

e Fa e = R,

&dd Mew Llseri

:JJJ .27 Add New User

3. MUNT10aZIDeA account user
User Name : "']#;E] login
Real Name : $0-113/27)a93 4
Password : SHAH1U
Confirm Password : SUUIHarrNE

' ¥ o 2 A 1y
%99 Forward Address n38iAnan1s forword ludaaou (lidesszy)
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Add Hew User [z|

General | Einger Infamation

User Name: | E
Beal Mame: |A.Amut Ruttanatirakul

LConfirm Pazzwond: |

|
| Pazsword: | s |

‘ Fornward Address: |

Fieturn Address | |
|

[ ok J[ cocel |[ Hew |

a 4 =
jjJ .28 NUNI1YALIDYA account user

A LAy 9 Ao J a 9 A Aa
4. WY Account mail ﬂ@]@ﬂﬂ’liiﬂfﬂﬂﬁﬂﬂ ﬂimﬂ’lnﬂuqu@]ﬂi\iﬁ1ﬂ'ﬁﬂchﬁf@Fﬂﬁ\‘l“l/‘lﬂﬁﬂll

Y .. Y
1A webmaster, admin, info, sale A3 1/ n.29

User, Setup le
2 -

(LI B | O L I
arnt bee sutida apirak. webmaster
O

E”]J .29 1NN Account mail

5. ﬂaﬂﬂu Close

6. aantju Start iersuilaldan dagil n.30

“& ArGoSoft Mail Server
File Tools Help

G

S8 E004 1E5:-F24:35 - BT
SAESE004 15:24:40 - PO]
ESESEO04 15:-74:40 - Fir
AARSFNN4 1E-74-4N0 — Rwva

51 .30 1Ju Start tvo1FuTa 1Ha11
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1571 AIFANTIUN Mail aransalsau Idesanse luTaelgmids telnet 1989 port

J o
vyoaua fe31l n.31

Start > Run... ﬁl]ﬁ
telnet 127.0.0.1 25 <naaou SMTP

telnet 127.0.0.1 110 < NAd0LU POP3

- Type the name of a program, folder, document, ar
Internet resource, and Windows will open it For wou,

Open: |telnet 127.0.0.1 25

|

Ok, |[ Cancel H Brawse. .. ]

% Telnet 127.0.0.1

2280 ArGoSoft Mail Server Freeware,. Uersion 1.8 <1.8.6.8>

test port 25

% Telnet 127.0.0.1

+0K ArGoSoft Mail Server Freeware. Uersion 1.8 <1.8.6.6>

test port 110

71 n.31 nATEUMIINNUYBI Mail

M3158n1991% ArGoSoft Mail

d'dy =l 9 1 Y a3 4 a 4 I
1. GLUVIUVI@’CT@TJL?EJﬂGlGHQTHNTUVIN‘WUTL'J’UII“H@I Iﬂﬂﬂ?iWN‘W URL 19
http://127.0.0.1/ < i5on1as 14 localhost
=
NI

http://192.168.10.1/ < (Senlaeldy ip address Aagl n.32
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2N ArGoSoft Mail Server - Microsoft Internet Explorer

: Ele Edit Wiew Favorites  Tools  Help
| address | &] hitp:f127.0.0.4)

Date 6/6/2004 Time 16:33:00

A e Star Experience
,: FW@MWW# o,

Welcome to ArGoSoft Mail Server

You can check your mail from here

[ Add Mew Lser l

51/ n.32 M3i5en 19911 ArGoSoft Mail Server
2. Aanju Login tWoiihszu

a oA A YA 9 ' ¥ & o
3. WUNYD user/password Vl!inlﬂl‘WﬂJlslnﬁgUUﬂ@‘Hﬁu']u PN ﬂ .33

Connect to 127.0.0.1

0
:
ArGoSoft Mail Server
User name: € arrut v|
Password: | soee |

[Jremember rmy passward

[ o i [ Cancel

51 n.33 msAadedsz
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4. UARINTIIIO ArGoSoft Webmail 91931/ n.34

User arnut

You have O messages waiting.

% Compose X Delete v Check Mail % Settings ] Log Out

| From | Subject L Date | Size |

_ GETIFREE STUFF.

ArGoSoft Mail Server Freeware, Yersion 1.8 (1.8,6.0)
51/ .34 1EAINI99 ArGoSoft Webmail

[

o o (% [ o
puuWesuaMSUawNa aasll n.35

u

R Send % Attach Msyg List ] Log Out

If you wish to send the mail to multiple recipients, separate names and addresses by commas,

Mame of Sender: |A.Arnut Ruttanatirakul

Ermail of Sender: |bee@siamcum.cu.th

Mame(s) of Recipient{s): |

Email{s) of Recipient(s:

Mame(s) of CC Recipient(s):

Email{s) of BCC Recipient(s):

|
|
Email{s) of CC Recipient(s): |
|
|

Subject: testmail j2.
Message Body: VmEaURSA 1
Attachments:

51l n.35 osumsduna
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1. 113 copy Inlamesnye Ipdnf Aaamfuusy D ROM 11311 C/AppServiwww

ile Edt Mjew Faworites Toals  Help
I X!

eﬂack - l\_-) v l.‘fﬁ;

fddress Il.ﬂ Di\app

|'-'_

)
7 Search Y- Folders

—

-

: g et
] ! Win32-2.4.4
Fﬁ ApPsEry-win a L’(J lndhf

51/ .36 uaasmM N copy I

2 )
1.2 Yuae lazidlunsad1a Database 141500 389AM13 75031 phpMyAdmin  Jila

Brower (@3N http://localhost/phpMyAdmin/ Turo9 Address ﬁﬂg 1 n.37

7 phpMyAdmin vivawaguu localhost - phpMyAdmin 2.5.7-pl1 - Microsoft Internet Explorer =] 4
Fle Edt ‘iew Favortes Tools  Help | o
esack - @ - |£] @ \:j | ;J Search '?i\L.(F uuuuu tes €3| [_:- :\7 -

Address [ http:y/localhastprptyAdming =l &
L phpMyAdmin 2.5.7-pl1 uddaniu

wininu

MySOL 4.0.24-nt it wadjuu localhost uifia root@localhost

(gudaya) ... ¥

MyS0OL phpMyAdmin

TusBangnidaya - @ gy T [Iﬂﬂﬂ'"ﬁﬂ;fﬂ\]] I Language (*3: IThai (th-tis-620) ﬂ
— T T B

- wanssas T phpMyAdmin

= WAEFOUEas MySOL - wEEfinyauad PHP

- uARFLlTTruLna MySOL [lanaisdieis] - Taumaatiafhuienisuas phpityadmin
- uARina e MySOL  [lanansdiaia] [ChangeLog] [Cvs]  [Lists]

- 3 Tac MySOL T [lanans&wba)

- fnE

- gudoys

- @aaon

Aasriniunen $cfgl'PmaAbsoluteuri'] halvidmauiinqsshadanou

51 n.37 ueraamsdunlu phpMyAdmin
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3. af g udoyai¥odn df naz1¥iden Chareset 1T Thai (th-tis-620) fa31) n.38

9 localhost f localhost | phpMyAdmin 2.9.2 - iLLUSION

File Edit Wiew Favorites  Tools  Help

EMySQL connection collation: Bianansensid phphyAdmin
HsB20 thai ci ) fHawaadiaflunanisuas phphyAdmin

b [Changelog) [CWS] [Lists]
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